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  Gli articoli contenuti in questa rivista sono stati rilasciati sotto la licenza Creative Commons Attribuzione - Non commerciale - Condividi allo stesso modo 3.0. Ciò significa che potete adattare, copiare, distribuire e inviare gli articoli ma solo sotto le seguenti condizioni: dovete attribuire il lavoro all'autore originale in una qualche forma (almeno un nome, un'email o un indirizzo Internet) e a questa rivista col suo nome ("Full Circle Magazine") e con suo indirizzo Internet www.fullcirclemagazine.org (ma non attribuire il/gli articolo/i in alcun modo che lasci intendere che gli autori e la rivista abbiano esplicitamente autorizzato voi o l'uso che fate dell'opera).

  

  Se alterate, trasformate o create un'opera su questo lavoro dovete distribuire il lavoro risultante con la stessa licenza o una simile o compatibile. Full Circle è completamente indipendente da Canonical, lo sponsor dei progetti di Ubuntu, e i punti di vista e le opinioni espresse nella rivista non sono in alcun modo da attribuire o approvati da Canonical.


  
    Nota: gli articoli in questa magazine sono forniti assolutamente senza alcuna garanzia; né i contributori né Full Circle Magazine accettano alcuna responsabilità o onere per perdita o danneggiamento risultato dalla scelta dei lettori di applicare questi contenuti ai computer loro o di terze parti od equipaggiamenti.
  


  Ecco a voi un altro 'Speciale monotematico'


  Un'altra serie, un'altra compilazione di articoli per la vostra comodità.


  Ecco la ristampa della serie ' Inkscape ' parti 1-7, pubblicata nei numeri 60-67.


  Vi preghiamo di tenere conto della data di pubblicazione: le versioni attuali di hardware e software potrebbero essere diverse rispetto ad allora. Controllate il vostro hardware e il vostro software prima di provare quanto descritto nelle guide di queste edizioni speciali. Potreste avere versioni più recenti del software installato o disponibile nei repository delle vostre distribuzioni.


  Buon divertimento


  
    Si prega di notare che questa edizione speciale viene fornita senza alcuna garanzia: né chi ha contribuito né la rivista Full Circle hanno alcuna responsabilità circa perdite di dati o danni che possano derivare ai computer o alle apparecchiature dei lettori dall'applicazione di quanto pubblicato.
  


  Inkscape - Il formato file SVG


  di Mark Crutch


  Immaginate di dare istruzioni a qualcuno affinché disegni una casa. Vi è la seria possibilità che descriviate forme geometriche e le loro relative posizioni. “Disegna un grosso rettangolo rosso lungo circa la metà della pagina, approssimativamente in mezzo e un po' più largo che alto. Adesso metti un triangolo grigio in cima ad esso che sia un po' più ampio così che sporga sopra ai bordi...” Le medesime istruzioni funzionerebbero per qual unque dimensione della tela, da una cartolina a un cartellone.


  Avete appena immaginato il mondo della grafica vettoriale.


  Quando fate una foto o create un'immagine in GIMP state lavorando con la grafica raster, a volte chiamata bitmap (non è la stessa del formato di file .bmp, sebbene quello sia un esempio di grafica bitmap). Un grafico raster o bitmap essenzialmente è un elenco di pixel colorati che dice al computer di disegnare un pixel rosso, poi un pixel blu, poi uno verde... e così via, pixel dopo pixel, rigo dopo rigo fino a che non si è raggiunto l'ultimo pixel.


  I grafici vettoriali, diversamente, consistono in una serie di istruzioni. “Disegna un cerchio rosso con un raggio di 10 unità, centrato alle coordinate X,Y. Adesso disegna una linea blu dall'angolo superiore sinistro della pagina a quello inferiore destro.” Quel cerchio rosso potrebbe avere un raggio di 10 pollici o potrebbe essere di 10 miglia, volendo dire che, diversamente dalle immagini raster, i grafici vettoriali possono essere scalati senza nessuna perdita di qualità.
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    Un piccolo cerchio scalato come immagine bitmap (a sinistra) e come immagine vettoriale (a destra).
  


  Proprio come vi sono molti formati raster – JPEG,GIF, PNG, BMP per nominarne solo alcuni – così vi sono anche molti formati vettoriali. Molti di loro vengono sviluppati da applicazioni proprietarie come DWG di AutoCAD o AI di Adobe Illustrators, ma uno in particolare è un formato aperto, definito dal W3C, lo stesso corpo di standard che è responsabile per il formato HTML che guida il web. I grafici vettoriali sono, per loro natura, scalabili ma ciò non li esonera dal cercare di essere assolutamente sicuri che sappiate ciò che avreste col loro formato: così l'hanno chiamato “Scalable Vector Graphics” (Grafica Vettoriale Scalabile) o SVG.


  Gli SVG sono semplice testo che contiene gruppi annidati di “tag”, etichette, in maniera similare ai file HTML. Vi è un'etichetta <circle>, cerchio, un'etichetta <line>, linea, e così via. Essi possono essere modificati utilizzando qualsiasi editor di testo sebbene, dato che un'immagine diviene sempre più complessa, di solito è più facile usare un programma di disegno per modificarli. Probabilmente il software meglio conosciuto per questo è Inkscape (www.inkscape.org) che può essere trovato nei repository di molte distribuzioni Linux, Ubuntu inclusa, ed è disponibile anche per Windows e MacOS. Inkscape usa SVG come suo formato di file primario, il che lo rende uno strumento fantastico per creare o modificare file SVG ma che pone anche un limite alle capacità del programma. Con un serio lavoro in corso sulla definizione della versione 2.0 del formato SVG, negli anni a venire Inkscape dovrebbe, si spera, essere in grado di guadagnare terreno sulla concorrenza proprietaria.
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  La struttura simile ad HTML dei file SVG, insieme alle loro origini presso il W3C, li ha resi lo standard ufficiale per la grafica vettoriale nel mondo del web. Ciò ha richiesto molto tempo ma adesso molti browser web supportano nativamente i file SVG ed è possibile mescolarli direttamente nei file HTML, l'ideale per i grafici in linea o le mappe. La struttura gerarchica dei tag è anche aperta alle modifiche con Javascript allo stesso modo del contenuto HTML, consentendo a chiunque abbia delle competenze nello sviluppo web di creare grafici interattivi. Comunque, come spesso avviene, il supporto specifico varia tra i browser e alcune caratteristiche più avanzate del formato SVG potrebbero non essere visualizzate allo stesso modo in ognuno di essi.


  SVG è fantastico per diagrammi, grafici interattivi e anche lavori artistici ma ha anche un altro asso nella manica che lo eleva oltre l'innato buon funzionamento e la semplicità della pura grafica vettoriale: supporta anche le immagini raster. Al livello più semplice, è possibile includere un'immagine raster in un file SVG, poi disegnare delle linee e dei cerchi sopra essa o tagliarla in una forma strana usando un tracciato SVG. Ma le immagini raster possono anche essere usate come motivi di riempimento nei file SVG: Inkscape è fornito di alcune di loro come predefinito e io personalmente ho usato la texture sabbia (che sembra come il rumore o la neve su una televisione non sintonizzata) come aiuto per imitare pietra, cenere, mattoni e anche un campo di grano!


  Andando ancora oltre, SVG possiede la nozione dei filtri, operazioni matematiche che possono essere combinate ed applicate ai pixel trasformati in raster nella vostra immagine finale. L'immagine è ancora fatta di vettori ma, una volta che questi vettori sono stati disegnati, i filtri possono creare ogni sorta di effetti raster grunge che di solito richiederebbero un programma come GIMP o Photoshop. Guardate come un po' di filtri possono cambiare delle informi masse vettoriali semi casuali in una palla di fuoco esplosiva:
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    Alcune semplici masse vettoriali...
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    ...portate alla vita con alcuni filtri SVG
  


  Che vogliate disegnare icone per una applicazione usando Inkscape, grafici per un sito web usando Javascript o arte astratta usando un editor di testo, SVG è un formato potente e flessibile che promette anche più negli anni a venire. Quindi accaparratevi una copia di Inkscape usando il vostro gestore di pacchetti e andate a disegnare.


  Collegamenti utili:


  Inkscape: http://www.inkscape.org

  Forum utenti Inkscape: http://www.inkscapeforum.com

  Icone SVG Tango: http://tango.freedesktop.org/

  Gruppo di Lavoro W3C SVG: http://www.w3.org/Graphics/SVG/


  Nel prossimo mese avremo il nostro primo contatto con Inkscape. Rimanete aggiornati!


  
    Mark utilizza Linux dal 1994 e usa Inkscape per creare due fumetti-web, 'The Greys' e 'Monsters, Inked', che si trovano entrambi su: http://www.peppertop.com/
  


  Inkscape – Parte 1


  di Mark Crutch


  Prima che passiate oltre a questo tutorial pensando che non è roba per voi, vi confiderò un piccolo segreto: non so disegnare. Se mi date un foglio e una matita, o mi mettete di fronte a GIMP con una costosa tavoletta grafica, sarei facilmente surclassato da un bimbo di quattro anni. Però, in qualche modo, sono uno degli artisti di una serie di fumetti online. E quindi, come può un pittore rupestre con le dita grosse come me realizzare lavori artistici? Uso Inkscape.


  Inkscape non è un sostitutivo di un occhio artistico, o di tre anni di scuola d'arte, ma se il vostro problema è soprattutto la coordinazione mano-occhio, allora offre qualcosa che le matite e GIMP non offrono. Dà l'opportunità di elaborare e modificare ogni linea e figura che disegnerete, finché non sarete soddisfatti del risultato. Se le vostre linee disegnate a mano si avvicinano, ma non del tutto, a quello che avete immaginato, Inkscape vi dà il tempo e gli strumenti per alterarle, piuttosto che gettare via tutto e provare di nuovo. Quindi, prima che abbandoniate questo tutorial poiché non avete un talento naturale, perché non tentate comunque? Potreste rimanere meravigliati. Se l'arte è una vostra dote naturale, allora avrete già un buon punto di partenza, ma spero sarete in grado di cogliere qualche consiglio e trucco lungo il tutorial, specifico per Inkscape.


  Iniziamo con il procurarci una copia di Inkscape. È nei repository della maggior parte delle distribuzioni Linux, quindi basta usare il normale gestore di pacchetti. Questi tutorial si baseranno sulla versione 0.48, che da un po' di tempo è la versione stabile.


  Al primo avvio di Inkscape vi troverete davanti a un'area di lavoro vuota, circondata da una varietà di barre degli strumenti e da una barra dei menu nella parte alta della finestra (o dello schermo se state usando Unity su un rilascio di Ubuntu recente). Il posizionamento esatto delle barre degli strumenti può essere limitatamente modificato: potete visualizzarle e nasconderle usando il menu Visualizza>Mostra/Nascondi e potete passare attraverso tre diversi layout predefiniti usando le opzioni Predefinito, Personalizzata, Larga in basso nel menu Visualizza. Per questi tutorial userò il layout Personalizzata (pessimo nome, visto che non permette di personalizzarlo granché), con tutte le barre visibili e che si produce in una finestra principale simile a quella mostrata sulla sinistra.
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  Ora, disegniamo qualcosa. Dalla barra degli strumenti (che trovate in basso sulla sinistra indipendentemente dal layout dello schermo utilizzato), fate clic sullo Strumento Cerchi ed Ellissi [image: ]. Muovete il cursore sull'area di lavoro e dovreste notare che il puntatore è cambiato per indicare che state usando lo strumento Cerchi. Nell'area di lavoro vi è una sagoma che rappresenta la vostra pagina, sebbene Inkscape sarà lieto di lasciarvi disegnare al di fuori dell'area delimitata, che fornisce una vasta area per gli abbozzi, le immagini di riferimento o qualsiasi altra cosa che non volete appaia poi nella pagina stampata o nell'immagine esportata. Fate clic sulla pagina, quindi trascinate verso destra e verso il basso per creare un'ellisse, rilasciando il pulsante del mouse quando siete soddisfatti della dimensione e della forma. Il vostro sarà probabilmente di un colore diverso dal seguente, ma su questo provvederemo a breve.
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  La vostra ellisse dovrebbe avere una linea tratteggiata intorno, indicando che è attualmente selezionata. Molte operazioni su Inkscape agiscono solo sugli oggetti correntemente selezionati. Il modo più rapido per deselezionare ogni cosa è fare clic su una parte bianca dell'area di lavoro, lontana da qualunque altro oggetto che avete disegnato. Per riselezionare l'ellisse, fate semplicemente clic su di essa con lo strumento Cerchi ed Ellissi ancora attivo.


  Oltre la linea punteggiata, dovreste notare anche due piccoli quadrati e un piccolo cerchio sul bordo della vostra ellisse. Sono conosciuti come “Maniglie”, e sono un modo grafico per modificare alcune delle proprietà degli oggetti. Provate a muovere una delle maniglie quadrate trascinandola con il mouse: cambierà il raggio dell'ellisse in una direzione. La seconda maniglia quadrata modifica l'altro raggio.


  Il cerchio è leggermente differente, sono di fatto due cerchi uno sovrapposto all'altro. Permettono di trasformare l'ellisse in un segmento o un arco. Provate a trascinarne uno lungo il contorno dell'ellisse. Adesso trascinate l'altro. Inkscape prova a indovinare se desiderate un segmento o un arco, quindi passerà dall'uno all'altro a seconda di come muovete le maniglie. Potete passare da uno all'altro usando i pulsanti nella barra degli Strumenti di Controllo, appena sopra l'area di disegno. Premendo sul terzo pulsante le due maniglie circolari torneranno l'una sull'altra di nuovo, riottenendo nuovamente l'ellisse completa.
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  Diamo alla nostra ellisse un po' di colore. Selezionatela e date un'occhiata al pannello in basso a sinistra, nella finestra di Inkscape. Troverete un paio di campionari colorati relativi a Riempimento e Contorno. Riempimento mostra i colori che vengono utilizzati per disegnare l'interno della vostra ellisse, mentre Contorno indica i colori che vengono utilizzati per disegnare i contorni. Potete fare clic con il tasto destro sulla palette Contorno per selezionarne uno da alcune misure standard se pensate che il vostro contorno sia troppo sottile o troppo spesso.
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  Sopra questi due campionari, troverete ulteriori campionari di colore aumentando la finestra in tutta la sua larghezza. Ci si riferisce a questi come alla tavolozza di colori. Fate clic su un campionario della tavolozza per impostare il colore dell'oggetto attualmente selezionato e SHIFT-clic per impostarne il contorno. All'estrema sinistra della tavolozza vi è un campionario con una croce in mezzo che serve ad impostare il riempimento o il contorno su “trasparente”. Provate ad impostare l'interno come trasparente e dare un colore al contorno. Poi giocate con le maniglie circolari e il pulsante Segmenti ed Archi, ora dovrebbe essere più chiaro il motivo del suo nome.


  Infine, spostiamo l'ellisse su e giù per la pagina. Per farlo, dovete premere il pulsante Seleziona, ossia il primo pulsante nella barra degli strumenti che assomiglia ad una freccia [image: ] . Con questo strumento abilitato, potrete muovere gli oggetti semplicemente facendoci clic sopra e trascinandoli. Quando un oggetto è selezionato usando lo strumento Seleziona, lo vedrete circondato da una linea punteggiata, ma anziché i piccoli quadratini e cerchietti osservabili con lo strumento Cerchi attivo, vedrete delle maniglie a forma di frecce tutte intorno alla linea punteggiata.
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  Trascinare queste maniglie vi permetterà di cambiare larghezza e altezza dell'ellisse. Nonostante possa sembrare che abbiano lo stesso comportamento delle maniglie quadrate usate in precedenza, sono leggermente differenti. Provate a fare clic sull'ellisse una seconda volta, come se voleste selezionarla di nuovo. Le frecce delle maniglie cambiano aspetto e una piccola crocetta compare nel centro dell'oggetto.
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  Trascinando le freccette agli angoli potrete ruotare l'oggetto. Le maniglie ai lati vi permettono invece di inclinarlo. Provate a giocarci un po' per capire come funzionano. Potete spostare poi la piccola crocetta altrove per cambiare il centro di rotazione; SHIFT-clic su essa per farla tornare al centro dell'oggetto. Con un singolo clic sull'ellisse si tornerà dalle freccette per il ridimensionamento a quelle per la rotazione.


  Un doppio clic permetterà invece di passare allo strumento Cerchi, ripristinando nuovamente le maniglie quadrate e i cerchietti. Provate a ruotare l'ellisse usando lo strumento Seleziona, quindi fatevi un doppio clic per abilitare le maniglie quadrate usandole per modificarla. Tornate poi allo strumento Seleziona e cambiate l'altezza e la larghezza usando le maniglie a freccia. Vedete, ve l'ho detto che erano differenti!


  Se disegnate qualche altro cerchio ed ellisse e li muovete nello spazio disponibile, vi accorgerete presto che si possono sovrapporre e oscurare l'un l'altra, in quanto è come se fossero accatastati. Quando selezionate un oggetto con lo strumento Selezione, troverete un gruppo di quattro icone che vi permettono di muovere i vostri oggetti su e giù in modo che possano apparire d'avanti o dietro gli altri oggetti. Il primo e l'ultimo pulsante permetteranno ai vostri oggetti di saltare direttamente d'avanti o dietro la catasta, mentre il secondo e il terzo modificheranno la posizione degli oggetti un livello alla volta.
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  Talvolta potreste avere bisogno di una vista ravvicinata dell'oggetto creato o di fare una panoramica. Vedremo dettagliatamente come farlo nell'ultimo articolo, ma per il momento potete usare i tasti più (+) e meno (-) sulla tastiera per fare aumentare e diminuire lo zoom e la rotella del mouse per muovere la vista.


  Adesso sapete come creare ellissi, segmenti e archi, sapete cambiarne il colore e aggiustarne lo spessore del contorno. Potete muoverli dentro la pagina e spingerli su e giù nella catasta di oggetti che avete creato. Potete aumentare e diminuire lo zoom e muovere lo spazio di lavoro. La prossima volta introdurremo alcune nuove forme, ma potete realizzare qualche semplice immagine usando solo ellissi, segmenti e archi: sebbene non sia proprio la stagione adatta per farlo, che ne pensate di disegnare un pupazzo di neve?
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  Infine, dovreste salvare il vostro lavoro dal menù File>Salva (o Salva come...). C'è un menù a comparsa nella finestra di dialogo che permette di scegliere tra i vari formati. Per ora selezionate Inkscape SVG, la prima scelta nella lista; vedremo delle altre opzioni in una delle prossime dispense.


  
    Mark utilizza Linux dal 1994 e usa Inkscape per creare due fumetti sul web, 'The Greys' e 'Monsters, Inked' che potrete trovare su: http://www.peppertop.com/
  


  Inkscape – Parte 2


  di Mark Crutch


  Lo scorso mese abbiamo visto come tracciare ellissi usando lo strumento Crea Cerchi. Ma probabilmente avrete notato come di fatto non abbiamo disegnato alcun cerchio, a dispetto del nome dello strumento. Potreste avvicinarvi all'impresa sistemando un'ellisse ad occhio, ma non è esattamente come disegnare un cerchio perfetto. Il segreto per disegnarne uno perfetto in verità è il segreto per usare al meglio tutte le potenzialità di Inkscape: occorre usare la tastiera.


  Inkscape possiede uno straordinario numero di tasti rapidi e modificatori. Lo scorso mese, ho accennato all'uso dei tasti Più e Meno per ingrandire o rimpicciolire, ma ci sono centinaia di combinazioni elencate sul manuale di riferimento per l'uso della tastiera e del mouse; il collegamento è alla fine di questo articolo, ma potrete anche raggiungerlo attraverso il menu Aiuto del programma. Un numero di scorciatoie così grande può essere dispersivo, per cui ve le introdurrò poco per volta, cominciando con i tasti CTRL e SHIFT.


  Questi due tasti hanno diversi utilizzi a secondo di cosa state facendo con Inkscape nel momento in cui li premete, ma, in linea di massima, hanno solitamente questo fine:


  
    	CTRL: Blocca o cattura alcuni aspetti dell'operazione


    	SHIFT: Modifica il centro o il punto iniziale di un'operazione

  


  “Un' operazione” in questo caso si riferisce al disegnare, ruotare, distorcere o altro mentre si manipola un oggetto. Diamo un'occhiata ad ognuno di questi modificatori sulla tastiera quando vengono usati con il nostro strumento Crea Cerchi ed Ellissi.


  Selezionate lo strumento Crea Cerchi facendo clic sulla sua icona, o premendo il tasto “e” (per ellisse) oppure F5. Adesso tenete premuto il tasto CTRL mentre disegnate un'ellisse nello spazio di lavoro. Noterete che non potrete sistemare altezza e larghezza dell'ellisse, ma piuttosto queste ricoprono delle proporzioni predefinite; 1:1, 1:2, 3:1, e così via. Quindi la risposta alla domanda su come disegnare un cerchio è semplicemente tenere premuto il tasto CTRL mentre si disegna un'ellisse.
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  Oltre a bloccare le proporzioni nel momento in cui si disegna un oggetto, il tasto CTRL può anche essere usato per catturare le vostre modifiche che vanno oltre i valori standard. Provate a selezionare la vostra ellisse con lo strumento Crea Cerchi attivato, quindi muovete le piccole maniglie di controllo circolari (quelle per trasformare l'ellisse in segmento o arco) mentre tenete premuto il tasto CTRL. Potrete osservare che le maniglie spazzano angoli particolari, solitamente di 15°. Potete cambiare tale valore andando su File > Preferenze di Inkscape > Scatti, dove potrete scegliere tra una gamma di valori angolari che compaiono in un menu a tendina, sebbene il valore predefinito è una buona scelta per la maggior parte degli utenti.
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  [image: ] Adesso provate a selezionare un'ellisse con lo strumento Seleziona (pagina precedente, icona da puntatore), quindi fate clic una seconda volta per abilitare le maniglie di rotazione e distorsione. Tenete premuto CTRL mentre ruotate l'oggetto, e noterete come interverrà la stessa azione di cattura. La stessa cosa anche per la distorsione, ma è un po' meno ovvio con un'ellisse, per cui ci ritorneremo su tra breve.


  Fate nuovamente clic sull'ellisse per tornare alle maniglie di spostamento e scala. Se provate a trascinare l'ellisse in giro, potrete osservare come CTRL permette, da premuto, soltanto movimenti verticali e orizzontali. Ora, provate a ridimensionare con le maniglie a freccia e scoprirete che il tasto CTRL blocca il rapporto d'aspetto della vostra ellisse; potrete renderla più grande o più piccola, ma manterrà sempre la stessa proporzione tra altezza e larghezza.


  Se usate un mouse con la rotella, il tasto CTRL ha un'altra funzione: tenetelo premuto mentre usate la rotella del mouse per effettuare un ingrandimento o rimpicciolimento del vostro documento. Mentre giochicchiate fate ciò inoltre, provate ad usarla per trascinare lo spazio di lavoro; è molto più rapido che effettuare il pan usando la barra di scorrimento.


  Adesso diamo un'occhiata al tasto SHIFT. Tenetelo premuto mentre disegnate un'altra ellisse. Noterete che verrà disegnata a partire dal centro e non dal bordo. Uno degli usi più comuni del tasto SHIFT in Inkscape è cambiare il punto iniziale o di riferimento per un'operazione.


  Selezionate un'ellisse usando lo strumento Selezione, quindi tenete premuto il tasto SHIFT mentre la ridimensionate usando le maniglie a freccia. Notate come il punto di riferimento per le vostre azioni si è spostato sul centro dell'ellisse. Provate a premere e rilasciare SHIFT nel bel mezzo del ridimensionamento dell'ellisse per rendere questo comportamento ancora più evidente. Non dovete premere questi modificatori subito all'inizio di un'operazione, li potete usare in qualunque momento. L'unica accortezza da usare è tenerli premuti quando rilascerete il tasto del mouse.


  Fate un clic sull'ellisse per passare alla modalità rotazione, e premete SHIFT mentre ruotate o deformate usando le maniglie. Dovreste vedere una piccola crocetta che indica lo spostamento del centro di rotazione verso l'angolo o il lato opposto rispetto alla maniglia che state adoperando, e la vostra ellisse ruoterà o si deformerà rispetto a quel punto di riferimento.


  Potete anche combinare insieme i tasti CTRL e SHIFT. Premendoli entrambi mentre si disegna con lo strumento Cerchi si otterrà un cerchio perfetto partendo dal suo centro, mentre se lo si preme quando si ruota un'ellisse essa ruoterà di 15° per volta attorno all'angolo opposto alla maniglia di rotazione.


  Concludiamo per questo mese con una nuova figura: ci sono così tante cose che potete disegnare con cerchi ed ellissi, che creeremo anche rettangoli e quadrati.


  [image: ] Per fare ciò, useremo lo strumento Crea Rettangoli e Quadrati (illustrato a sinistra. Premete F4 o “r” per richiamarlo). Cominciate facendo clic su tale pulsante nella barra degli strumenti, quindi tracciate la sagoma sullo spazio di lavoro, proprio come avete fatto per le ellissi. Dovreste avere un bel rettangolo:
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  Fate caso al fatto che il vostro rettangolo ha piccoli quadratini e maniglie circolari esattamente come quelli dell'ellisse. Esse permettono di impostarne altezza e larghezza; premete il tasto SHIFT mentre le adoperate per permettere modifiche solo lungo una direzione o nell'altra. Le manopole circolari, esattamente come quelle dell'ellisse, sono in realtà due manopole sovrapposte. Muovetene una (o premete CTRL mentre ne muovete una qualsiasi) e otterrete degli angoli arrotondati e simmetrici attorno al rettangolo di circa un quarto di cerchio. Al contrario, muovetele entrambe per ottenere degli angoli arrotondati a mo' di ellisse. Se volete tornare agli angoli perfetti di 90° basta fare clic mentre si preme SHIFT su una delle maniglie circolari, oppure usare il pulsante alla fine della barra degli strumenti di controllo (appena sopra lo spazio di lavoro).
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  I tasti CTRL e SHIFT funzionano per i rettangoli in maniera veramente similare ai cerchi: se volete creare un quadrato perfetto tenete premuto il tasto CTRL mentre disegnate un rettangolo per condurlo verso rapporti d'aspetto fissati; oppure premete il tasto SHIFT se volete disegnarli dal centro verso l'esterno anziché da angolo ad angolo.


  Ovviamente potete cambiare il colore del riempimento e del contorno per i vostri rettangoli, esattamente come abbiamo fatto lo scorso mese con le ellissi. Potete anche usare lo strumento Seleziona per muovere, ridimensionare, ruotare e deformarli, e tenendo premuto il tasto CTRL mentre li si deforma, diventa ancora più ovvio capire cosa avviene rispetto al caso delle ellissi.


  Adesso che avete creato rettangoli e quadrati, perché non arricchire il pupazzo di neve che avete disegnato lo scorso mese aggiungendo un cappello e una pipa?
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  Link utili:


  Guida di riferimento per l'uso di tastiera e mouse: http://inkscape.org/doc/keys048.html


  
    Mark utilizza Linux dal 1994 e usa Inkscape per creare due fumetti sul web, 'The Greys' e 'Monsters, Inked' che potrete trovare su: http://www.peppertop.com
  


  Inkscape – Parte 3


  di Mark Crutch


  Ecco un indovinello per voi: quando un cerchio non è un cerchio? O più specificatamente, quale di questi due cerchi è un cerchio e quale non lo è?
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  Possono sembrare uguali, ma non lo sono. Se fate doppio-click sopra ciascuno di essi per rendere visibili le maniglie di modifica, potete iniziare a notare una differenza.


  Quello a sinistra è un vero cerchio, creato tenendo premuto CTRL durante il disegno di un ellisse. L'altro è un quadrato, creato tenendo premuto CTRL durante il disegno di un rettangolo, il quale ha gli angoli arrotondati fatti usando la maniglia fatta a cerchietto.
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  Spesso è evidente su quale tipo di oggetto state lavorando con Inkscape, ma i vostri disegni possono diventare così complessi, e voi potete trovarvi a usare così tanti strumenti, che può diventare facile perderne traccia. Alcune caratteristiche funzionano solo con particolari tipi di oggetti, così è facile capire al volo cosa avete selezionato. Inkscape vi dà queste informazioni - e molte altre - nella barra di stato in fondo alla finestra. Qui la corrispondente immagine della barra di stato quando uno dei "cerchi" è selezionato con lo strumento "Seleziona":
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  Da queste informazioni risulta ovvio che i due cerchi sono differenti. Ma quest'immagine è stata leggermente modificata; il testo attualmente recita "Ellisse in Livello 1. Clicca la selezione per alternare le maniglie di ridimensionamento/rotazione". La barra di stato vi sta dicendo che cliccando il vostro oggetto selezionato alternerete tra le maniglie di ridimensionamento e quelle di rotazione & distorsione.


  Infatti molto di quello che è stato verbalmente descritto nei precedenti due articoli può essere trovato scritto in maniera più succinta nella barra di stato di Inkscape. Con lo strumento Cerchio selezionato vi viene detto di "Trascinare per creare un ellisse. Trascinare i controlli per creare un arco o un segmento. Cliccare per selezionare". In questo caso "Trascinare i controlli" nella terminologia di Inkscape significa muovere le maniglie fatte a cerchietto e quadrato. Allo stesso modo quando è selezionato lo strumento Rettangolo vi viene suggerito che potete "Trascinare i controlli per arrotondare gli angoli e ridimensionare".


  Muovendo il puntatore del mouse sopra le varie maniglie vi vengono date altre preziose informazioni nella barra di stato, inclusa questa perla per cui quando trascinate le maniglie fatte a cerchietto su un ellisse vi viene detto: "...trascinare dentro l'ellisse per un arco, fuori per un segmento." Quindi se vi steste chiedendo come mai Inkscape sembra commutare apparentemente in maniera casuale tra archi e segmenti, in realtà scoprite che non è poi così casuale dopotutto. Trascinate il puntatore verso dentro il margine dell'ellisse se volete creare un arco, fuori se volete creare un segmento - sebbene possiate sempre cambiare usando i pulsanti della barra degli strumenti se vi trovate bloccati con il tipo sbagliato di oggetto.


  Così come questi pratici suggerimenti, la barra di stato ospita anche alcune altre cose con le quali dovreste prendere familiarità se volete risparmiare molto del vostro tempo con Inkscape. All'estrema sinistra ci sono i campioni di disegno e riempimento che sono stati introdotti nella prima parte di questa serie. In teoria voi potete cliccare e trascinare su di essi per cambiare i loro colori, ma io l'ho sempre trovato un approccio impreciso e scomodo. Il prossimo mese guarderemo al menu Disegna e Colora che è un modo molto migliore per scegliere i colori che non sono presenti nella vostra tavolozza dei colori.
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  Lo spessore del tratto offre un ugualmente inutile agevolazione di clicca e trascina per cambiare il suo valore. Per ritocchi più veloci fare un click col tasto destro nel numero per aprire il menu contestuale è un'opzione migliore.


  La casella di immissione etichettata con un criptico "O:" vi permette di impostare l'opacità del vostro oggetto selezionato. Viene mostrata come percentuale, così 100 è la norma per un colore completamente opaco mentre 0 rende il vostro oggetto completamente trasparente. Inkscape ha molti modi per rendere i vostri oggetti trasparenti, e ciò può rappresentare un problema per i neofiti. Potete impostare un valore in questa casella digitandolo direttamente, o usando i pulsanti alto e basso a lato, o facendo click col tasto desto per fare apparire un semplice menu a cinque voci. Io di solito uso il menu contestuale come punto di partenza e, se non altro, fornisce un modo rapido per riportare l'opacità al 100% quando siete preoccupati di perdere i vostri oggetti trasparenti.


  Le icone con l'occhio e il lucchetto, e il relativo menu a comparsa, sono tutti collegati ai livelli. Tratterò i livelli prossimamente in un altro articolo; però ci sono tre cose che vale la pena di sapere già adesso:


  
    	se avete familiarità con i livelli di GIMP o un altro programma di grafica, i livelli in Inkscape funzionano in modo simile.


    	cliccare sull'icona con l'occhio è uno dei tanti modi per fare scomparire i vostri oggetti dallo schermo - in questo caso nascondendo i livelli nei quali sono stati disegnati. A questo punto l'icona cambia in un occhio chiuso e voi dovete semplicemente cliccare nuovamente sull'icona per visualizzare nuovamente il livello.


    	se l'icona del lucchetto appare come un lucchetto chiuso, allora il vostro livello è bloccato e voi non potrete trascinarvi sopra alcunché di nuovo. Cliccate nuovamente sull'icona per sbloccarlo.

  


  [image: ]


  Sulla destra del testo nella barra di stato ci sono un paio di campi che mostrano le coordinate X e Y del vostro mouse, riferite al margine alto-sinistra del limite della pagina. Non c'è modo di modificarli questi campi, che non sia muovendo il mouse; sono lì giusto per fornire informazioni. Tenete a mente, però, che l'opzione di Inkscape di tenere l'angolo in alto a sinistra come punto di partenza è diverso dalle specificazioni d'uso dell'angolo in alto a sinistra di SVG - non è una distinzione che può interessare a molte persone, ma questo significa che se voi siete dei programmatori che vogliono editare direttamente il file SVG, questi valori sono quasi inutili per voi.


  L'ultimo widget della barra di stato di Inkscape è una casella di selezione zoom che vi mostra l'attuale livello di zoom, vi lascia impostare un valore specifico digitandolo oppure usando i pulsanti alto e basso, oppure ancora vi permette di scegliere tra alcuni valori standard tramite un menu contestuale. Ci sono molti altri strumenti di zoom, inclusi il CTRL + rotellina del mouse e i tasti +/- che ho descritto precedentemente, ma comunque dubito che userete mai questo widget. Infine c'è una maniglia per ridimensionare la finestra.


  Finiamo questa edizione con uno strumento per disegnare da aggiungere al vostro arsenale: lo strumento Stelle e Poligoni. Esso ha un'icona nella barra degli strumenti [image: ] e può essere attivato anche usando il tasto asterisco (facile da ricordare perché ricorda un pochino una stella) oppure usando i tasti SHIFT + F9. Trascinando una forma sulla tela otterrete un poligono convesso o concavo, come una stella. Potete spostarvi tra questi due modelli usando i primi due pulsanti presenti nella barra di controllo degli strumenti.
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  A seconda di come lo state usando, potreste vedere una o due maniglie a forma di diamante. Queste vi permettono di regolare la dimensione, la rotazione e, per i poligoni concavi, il rapporto del raggio. Tenendo premuti alcuni tasti modificatori e muovendovi, potrete regolare diversi altri parametri (guardate nella barra di stato per i dettagli) - nonostante io di solito preferisca cambiarli usando le caselle di selezione presenti nella barra di controllo degli strumenti.
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  L'unico parametro che non potete cambiare attraverso l'uso delle maniglie a diamante, è il numero degli angoli del vostro poligono, ma l'altro vantaggio dell'uso delle caselle di immissione è questo: così come le caselle di immissione della barra di stato, anche queste hanno un menu contestuale al quale potete accedere con un click destro del vostro mouse. Questo menu contestuale è fatto su misura per ciascuna casella di immissione, con titoli descrittivi che vi forniscono una breve descrizione di ciò che effettivamente fanno.


  Il miglior modo per prendere confidenza con lo strumento Stella è giocare con esso. Provate differenti combinazioni di valori nelle caselle di immissione. Se i vostri oggetti iniziano ad andarvi fuori controllo premete il pulsante sulla destra nella barra di controllo degli strumenti - quello che appare come una piccola scopa - per "ripulire" i parametri e riportarli ai valori predefiniti. Per darvi un'idea di quello che potete ottenere semplicemente modificando i parametri dello strumento Stella, quest'immagine contiene sei poligoni identici i quali differiscono solamente nei valori inseriti nelle loro caselle di immissione:
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  Per ritornare alla domanda che ha aperto questo articolo, ora avete a disposizione un terzo modo per creare un "cerchio" - disegnando un poligono con un alto numero di angoli. Non è un modo particolarmente buono per disegnare un cerchio, e sicuramente non è efficiente, ma rafforza il fatto che in Inkscape gli oggetti non sono sempre quello che sembrano. Tenete d'occhio i parametri.


  Perché non usare questo nuovo strumento per aggiungere alcune stelle sullo sfondo del vostro pupazzo di neve degli articoli precedenti? Lo stesso strumento vi permetterà di sostituire quei cerchi che avete usato per gli occhi e la bocca con poligoni convessi leggermente randomizzati - sembreranno più degli autentici grumi di carbone.
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    Mark utilizza Linux dal 1994 e usa Inkscape per creare due fumetti sul web, 'The Greys' e 'Monsters, Inked' che potrete trovare su:http://www.peppertop.com/.
  


  Inkscape – Parte 4


  di Mark Crutch


  Questo mese daremo un'occhiata alle impostazioni dei colori dei vostri oggetti. Finora abbiamo applicato i colori al riempimento e ai contorni facendo clic e SHIFT-clic sulla tavolozza in basso nello schermo. È inoltre possibile impostare le trasparenze per entrambi usando la voce più a sinistra della tavolozza, quella con la croce sopra. Avrete probabilmente già scoperto la barra di scorrimento posta tra la tavolozza e la barra di stato, la quale vi permette di scorrere su tutta la collezione di colori nella tavolozza, ma avete notato il piccolo pulsante sulla destra dell'area della tavolozza, quello che assomiglia a un piccolo carattere "<"? Facendoci clic sopra vi verrà mostrato un menù a comparsa con le opzioni della tavolozza (all'estrema destra).
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  La gran parte di questo menù è occupato da una lista di tavolozze che è possibile usare. Provate a selezionarne qualcuna per vedere come si presentano. Quindi giocate con i sotto menù di Dimensione e Larghezza per trovare una campionatura ottimale per voi. Infine provate a selezionare la casella A Capo per capire subito come preferite vederle (anche se vi prenderanno più spazio in verticale), o potete utilizzare la barra di scorrimento nel caso abbiate bisogno di accedere a colori distanti tra loro.


  Se volete usare la vostra tavolozza personale, per essere compatibile con combinazioni di colori aziendali o per l'integrazione con altre icone di un'applicazione, potete importare un file tavolozza GIMP (.gpl) nella cartella inkscape/palettes, o in /usr/share/inkscape/palettes se volete renderla disponibile a tutti gli utenti del computer.
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  La tavolozza è ottima per selezionare rapidamente un colore per il contorno o il riempimento, ma nel caso vi servisse un colore non presente nella tavolozza? Ecco che la finestra Riempimento e Contorni vi viene in aiuto. Ci sono diversi modi per aprirla, compreso il pulsante Oggetto sulla barra in alto: selezionando un oggetto e facendoci clic sopra con il tasto destro del mouse e premendo poi Riempimento e Contorni, premendo CTRL-SHIFT-F o facendo clic in basso a sinistra sulla voce Riempimento e Contorni. Potete tenere posizionata sul lato destro della schermata di lavoro la finestre Riempimento e Contorni, oppure muoverla per conto vostro sull'area di lavoro trascinandola dalla barra grigia in alto.
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  In cima alla finestra ci sono tre schede per regolare il Riempimento, il Colore del Contorno e lo Stile del Contorno. Le prime due offrono pressappoco le stesse funzioni, così vi spiegherò la scheda Riempimento.


  Immediatamente sotto la scheda c'è una fila di pulsanti che servono per determinare qual'è il tipo di colore usato per il riempimento o il contorno. A sinistra c'è un pulsante per Nessun Colore che ha l'aspetto di una croce e che sortisce lo stesso effetto del pulsante con la croce in basso a sinistra della tavolozza, nella finestra principale. Nel caso in cui sia Riempimento che Contorno siano impostati su Nessun Colore, il vostro oggetto sarà completamente invisibile.


  Il secondo pulsante vi lascia scegliere un singolo colore per il Riempimento o per il Contorno. C'è da dire che è come scegliere un colore dalla tavolozza in basso, a parte il fatto che così avete maggior controllo sul colore. Premendo questo pulsante si presentano ancora più schede che offrono diversi metodi per scegliere il colore. Ma non fatevi ingannare: Inkscape usa valori RGB (Rosso, Verde e Blu) nei suoi file, anche se scegliete il colore tramite le modalità HSL o CMYK. Questo è un esempio di come Inkscape sia limitato nelle funzionalità del formato SVG. La scheda CMS serve solo nel caso usiate un sistema di gestione del colore nel vostro computer, ma ciò esula dallo scopo di questa guida.


  Qualsiasi colore abbiate scelto, troverete in basso un cursore contrassegnato con una "A". Questo è il "canale alfa", che è solo un altro modo di chiamare l'opacità. Se spostate questo cursore tutto a sinistra, il vostro Riempimento o contorno risulterà completamente trasparente. Se lo spostate tutto a destra, risulterà completamente opaco. Posizionato tra questi due estremi, darà qualche grado di trasparenza. Le immagini qui sopra mostrano gli stessi due oggetti con il Contorno completamente opaco, ma il Riempimento dell'oggetto in alto è, di volta in volta, impostato al valore 0, 128 e 255 (sopra).
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  Così come per l'opzione Nessun Colore, impostando entrambi i canali alfa, per Riempimento e Contorno, a zero si renderà il vostro oggetto completamente invisibile. Se il Riempimento o il Contorno sono parzialmente trasparenti, il campione di colore in basso a sinistra della finestra principale mostrerà una disposizione in due parti: la metà di sinistra mostrerà il colore, con l'alfa applicato, sopra a un effetto a scacchiera, mentre la metà di destra mostrerà una versione opaca dello stesso colore. Potete facilmente creare un riempimento trasparente o un contorno completamente opaco grazie al menu contestuale sul campione.


  Il terzo e il quarto pulsante vi permettono di utilizzare un gradiente per il vostro riempimento e Contorno. I gradienti saranno oggetto dell'articolo del prossimo mese, quindi ricordatevi che esistono questi pulsanti, ma per il momento li sorvoliamo.


  Il prossimo pulsante permette di colorare i vostri riempimenti o contorni usando un motivo. Inkscape viene fornito già con una varietà di righe e pallini che sono disponibili attraverso un menù a comparsa quando selezionate questa opzione. Molti motivi sono in bianco o nero, con un solo colore per motivo (mimetico) e tre immagini bitmap in scala di grigi che possono essere usate come motivi, proprio in fondo alla lista. Vi sarà possibile creare i vostri motivi personalizzati e regolare dimensioni e proporzioni di quelli integrati, ma questa è materia per un altro giorno.


  Sono tralasciati per successivi articoli anche il pulsante Unset Paint, che somiglia ad un punto di domanda, e le due chiazze sulla destra della scheda Riempimento.


  La terza scheda principale, nella finestra Riempimento e Contorno, è etichettata come Stile Contorno. Sebbene la scheda Colora Contorno è usata per impostare il colore, il gradiente o il modello che è usato per il Contorno, consente anche di gestire tutti gli altri parametri. La maggior parte di queste impostazioni possono essere regolate solo usando questa finestra, quindi vale la pena di familiarizzare con essa.
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  In cima c'è una casella di selezione, che vi permette di impostare la larghezza del tratto, e con essa un menù a comparsa per selezionare le unità di misura della larghezza. Queste duplicano le funzionalità disponibile mediante clic destro col mouse sulla barra di stato, ma offrono una vasta scelta di misure e un controllo più fine della larghezza del tratto. SVG attualmente permette al tratto di stare a cavalcioni sulla linea del contorno, mezzo dentro e mezzo fuori dall'oggetto. Potete vederlo con chiarezza riducendo il canale alfa di un contorno coperto, notando che il riempimento rimane nella metà interna del contorno. Vale la pena ricordare come i novizi di Inkscape si meravigliano spesso del perché aumentando lo spessore del tratto, diminuisca l'area interna delle loro figure.


  Poi ci sono tre pulsanti denominati Unione. Questi determinano come saranno disegnati gli angoli dei vostri oggetti, che possono essere aguzzi (acuti), arrotondati o smussati. La differenza tra queste modalità è facilmente visibile disegnando una stella.
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  Quando un angolo aguzzo è particolarmente appuntito, il punto di unione può eccedere leggermente la misura. In questo caso Inkscape disegnerà un angolo smussato al suo posto. La lunghezza a cui è permesso all'angolo acuto di arrivare è specificata dalla casella Spigolosità.


  Il pulsante Estremi riguarda la parte finale delle linee. Molti degli oggetti che abbiamo disegnato fin qua sono dei cerchi continui, perciò la parte finale non è del tutto definita, ma se usate le maniglie circolari per trasformare un ellisse in un arco, otterrete per forza un oggetto con una linea che finisce. L'opzione nel mezzo, Estremo arrotondato, conclude le linee con una punta semicircolare. Le altre due opzioni, Estremo geometrico ed Estremo squadrato, danno alle linee una fine squadrata e differiscono solamente nel finire oltre il punto di fine linea stabilito (Estremo squadrato), oppure esattamente nel punto di fine linea (Estremo geometrico).


  Il contorno non deve essere per forza una linea continua, può consistere anche in un tratteggio. Chiunque abbia trascorso del tempo con i disegni tecnici avrà familiarità con il trattino-puntino-trattino di una linea centrale, e una serie di trattini possono essere usati per dare un effetto artistico stile cucito. La casella Tratteggio vi permette di scegliere tra diversi motivi di tratteggio incorporati in Inkscape e con le adiacenti caselle di selezione potete regolare a vostro piacimento la relativa posizione iniziale del vostro modello. Il pulsante Estremi gioca un ruolo importante nei tratteggi; le immagini (sopra a destra) mostrano la nostra stella con un grosso tratteggio, ciascuno con uno dei tre diversi tipi di Estremo.
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  I tre menù a comparsa Delimitatore Inizio, Delimitatore Metà e Delimitatore Fine permettono di scegliere tra punte a freccia, rotonde, quadrate o altre forme che saranno posizionate sul contorno. Ripeto, le opzioni Inizio e Fine hanno più senso in una figura aperta, come un arco. In una figura chiusa vorrete forse utilizzarne una diversa. Il Delimitatore Metà appare nel caso in cui ci sia un angolo o una transizione tra due diversi tipi di segmenti, inclusi i passaggi da linea curva a linea retta in un rettangolo arrotondato. L'immagine (qui sotto) mostra tre esempi di delimitatori e tratteggi.
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  Prestate attenzione al fatto che i Delimitatori appaiono in nero, noncuranti del colore del contorno. Fortunatamente Inkscape contiene una estensione che modifica la necessaria struttura interna SVG; in tal modo, rendere corrispondenti i due colori è facile, basta selezionare il vostro oggetto e andare sul Estensioni > Modifica Tracciato > Uniforma colori, delimitatori e contorno. Anche usando questa estensione, comunque, il Delimitatore risulterà opaco, ignorando le impostazioni alfa del contorno.


  L'ultima parte della finestra Riempimento e Contorno da spiegare è la coppia di cursori in basso, per aggiustare la sfocatura e l'opacità. Il primo è una scorciatoia per aggiungere un filtro Gaussiano di sfocatura a un oggetto. I filtri SVG sono, di loro, un argomento importante per cui li vedremo in un articolo successivo, ma per adesso è sufficiente sapere che incrementando questo cursore il vostro oggetto diverrà più sfuocato. Più lo incrementate e più l'oggetto sarà sfuocato. Non esagerate: di solito un piccolo valore vi darà un buon effetto, mentre valori troppo elevati dissiperanno il vostro oggetto nella nebbia. Siate consapevoli che usare i filtri rallenterà la velocità con cui Inkscape ridisegna lo schermo, specialmente se usate uno zoom molto ampio.


  Il cursore dell'opacità ha lo stesso effetto della casella 'O' e del menù contestuale sulla barra di stato, ma con un controllo più capillare. Cambiare questo valore comporta l'opacità dell'intero oggetto, sia del riempimento che del contorno. Effettivamente, l'oggetto è disegnato in memoria usando valori alfa di riempimento e contorno, quindi questa intera immagine è disegnata sullo schermo usando l'opacità dell'oggetto. Questo effetto cumulativo rende possibile combinare valori di trasparenza in maniera complessa, non realizzabile con il solo alfa o la sola opacità. In questo esempio abbastanza appariscente, i quadrati hanno il 100% di opacità e alfa ma i cerchi hanno il riempimento, il tratto e i valori di opacità ivi indicati.


  [image: ]


  Il cursore dell'opacità è un metodo per fare un certo uso di questi modelli di riempimento incolore. Duplicando un oggetto (Modifica > Duplica) e quindi riempendo la copia con un modello e riducendo la sua opacità, potete permettere che il colore dell'oggetto originale si veda attraverso.


  Perché non usare questo trucco sull'immagine del vostro pupazzo di neve per dare una piccola granulosità alla copertura di neve sul terreno con l'aggiunta della texture Sabbia con una bassa opacità. Aggiungete alcune modifiche di colore, qualche traslucenza sulle ombre e dovreste notare che, con la vostra nuova maestria sulle finestre di dialogo Riempimento e Contorno, la vostra immagine inizia a sembrare un po' meno piatta.
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    Mark utilizza Linux dal 1994, e usa Inkscape per creare due fumetti sul web, 'The Greys' e 'Monsters, Inked' che potete trovare su: http://www.peppertop.com/
  


  Inkscape - Parte 5


  di Mark Crutch


  Il mese scorso ho introdotto la finestra Riempimento e Contorni come metodo per impostare colori uniformi o motivi sui vostri oggetti. Le specifiche SVG consentono anche che siano usati i gradienti ma, sfortunatamente, ne descrivono solo due tipi: lineare e radiale. Se avete usato i gradienti in altri programmi grafici potreste essere abituati a una maggiore varietà ma Inkscape è legato alle limitazioni delle specifiche SVG così, almeno per adesso, due tipi di gradienti è tutto quello che avrete. Inkscape ha per essi due pulsanti separati nelle schede Riempimento e Colore contorno della finestra: come potreste aspettarvi uno ha l'aspetto di un gradiente lineare: [image: ] e l'altro ha l'aspetto di un gradiente radiale: [image: ].


  Qualunque scegliate, vi troverete di fronte la stessa interfaccia utente all'interno della finestra.


  [image: ]


  La prima voce è un elenco pop-up dei gradienti che già esistono nel vostro documento. Il gradiente attualmente selezionato, in cima all'elenco, sarà quello nuovo che siete in procinto di creare. Se preferite usare un gradiente esistente allora potete semplicemente selezionarne un altro dall'elenco. A ciascun gradiente viene dato un nome poco intuitivo come il “Gradientelineare 3791” nella schermata. Sfortunatamente, Inkscape non fornisce una interfaccia utente pratica per modificare questo nome così, una volta che avrete più di una manciata di gradienti in un documento, può rapidamente diventare un elenco poco maneggevole che dà poche indicazioni su dove ciascuno sia usato nella vostra immagine.


  Il vostro nuovo gradiente prenderà sempre la stessa forma di base: ha un colore iniziale che è impostato ad una versione completamente opaca del vostro attuale colore di riempimento (o al nero se non è impostato alcun colore di riempimento) e ha un colore finale che è il medesimo del colore iniziale ma con il suo valore alfa impostato a zero. Il risultato è un gradiente che spazia da un colore opaco a uno trasparente, che va da sinistra a destra per un gradiente lineare e dal centro verso l'esterno per un gradiente radiale:


  [image: ]


  Se fate doppio clic sul vostro oggetto, così da entrare in modalità modifica e vedere le piccole maniglie che abbiamo esplorato nei precedenti articoli, scoprirete anche che sono apparse due o tre nuove maniglie, unite dalle linee e indicanti i punti iniziali e finali dei vostri gradienti, rispettivamente come maniglie quadrate e circolari. Potete trascinare in giro queste maniglie anche all'esterno dei confini del vostro oggetto per cambiare la posizione e l'angolo del vostro gradiente. Per i gradienti radiali i due punti finali possono essere mossi indipendentemente, consentendovi di avere dei gradienti circolari o ellittici.
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  Quando fate clic su una delle maniglie del gradiente vi accorgerete che la finestra Riempimento e Contorni ritorna alla modalità Colore uniforme con il colore selezionato riflesso anche nei campioni nell'angolo in basso a sinistra. Il colore che potete vedere è quello del punto finale selezionato del vostro gradiente, e potete cambiarlo in qualunque dei modi che abbiamo discusso in precedenza. Provate a selezionare la fine trasparente, a fare clic su un altro campione di colore e poi a giocare con il dispositivo di scorrimento dell'opacità o la casella di selezione “O”. Questo approccio vi permetterà di creare gradienti che si spostano dolcemente tra tutti e due i colori.
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  Un gradiente con due colori va benissimo ma che accade se ne volete tre, quattro, o un intero arcobaleno? Potreste creare oggetti multipli, ciascuno con una parte del gradiente complessivo, ma ciò diviene rapidamente complesso e poco maneggevole. Nella pratica la risposta è più semplice di quanto possiate pensare: creiamo solo più maniglie sui nostri gradienti. Invece di una maniglia iniziale e una finale ne avremo anche una o più nel mezzo. Ciascuna di queste maniglie definisce un particolare colore nel gradiente e ci si riferisce ad esse come “passaggio”.


  Per aggiungere un nuovo passaggio a un gradiente dobbiamo chiarire a Inkscape che vogliamo modificare il gradiente piuttosto che l'oggetto stesso, selezionando lo strumento Gradiente: [image: ] dalla casella degli strumenti (oppure premendo “g” o CTRL-F1). Ora è possibile fare doppio clic sulla linea che unisce i passaggi esistenti per aggiungere un nuovo passaggio. In modo predefinito sarà al colore e all'opacità a quel punto della linea, così l'aspetto visivo del vostro oggetto non cambierà ma, ora che esiste il nuovo passaggio, potete selezionarlo e cambiare il suo colore. Potete anche trascinare i passaggi lungo la linea, ammassandoli insieme per una transizione forte tra i colori oppure spargerli per qualcosa di più graduale. Con molta rapidità, è facile creare sgargianti gradienti multicolore, sebbene dei cambiamenti di colore più sottili tra i passaggi otterranno spesso un migliore effetto artistico.
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  Mentre è attivo lo strumento Gradiente potrete ancora muovere i passaggi finali per modificare la dimensione e l'angolo del gradiente. Quando avete terminato selezionate il vostro oggetto utilizzando lo strumento Selezione [image: ] per tornare alla vista familiare della finestra Riempimento e Contorno col gradiente al posto. Un'utile scorciatoia per questo passo è premere la barra spaziatrice. In molti casi ciò alternerà tra lo strumento attuale e lo strumento Selezione, tornando avanti e indietro a ciascuna pressione.


  Ritorniamo a un gradiente più semplice con soli due passaggi. Il modo rapido per far ciò è cambiare il vostro riempimento a Colore Uniforme e poi tornare di nuovo ad un gradiente, riportandovi alla disposizione predefinita di una sfumatura dall'opaco al trasparente, centrata sul vostro oggetto. La finestra Riempimento e Contorno dovrebbe, ancora una volta, avere un aspetto come nella prima immagine di questo articolo, dandoci la possibilità di esplorare le rimanenti opzioni nella schermata.


  Il pulsante Duplica è quasi autoesplicativo. Duplica qualunque gradiente sia selezionato correntemente nel menù a pop-up e applica il duplicato all'oggetto attualmente selezionato. Quest'ultimo punto è importante: significa che potete allegramente cambiare i colori dei passaggi e la posizione nel gradiente duplicato senza influire su qualunque oggetto che usa la versione originale. In quanto tale, può essere un conveniente punto di partenza se avete già un gradiente che è vicino a quello che vi serve ma non del tutto perfetto.


  Il pulsante... Modifica, ci ritorneremo a breve.


  Il pop-up Ripetizione viene usato per definire ciò che accade oltre l'inizio e la fine dei passaggi del vostro gradiente. L'impostazione predefinita è “nessuna”, nel qual caso l'area prima della maniglia d'inizio prenderà lo stesso colore della maniglia stessa e l'area oltre la maniglia finale, allo stesso modo, prenderà il colore del passaggio finale. Entrambe le altre impostazioni ripetono il gradiente: “riflessa” fa in modo che il si inverta gradiente per ciascuna ripetizione, dando una transizione dolce che si ripete come Inizio-Fine Fine-Inizio Inizio-Fine Fine-Inizio; “diretta” usa il gradiente così come è, dandogli un ciclo più brusco di Inizio-Fine Fine-Inizio Inizio-Fine Fine-Inizio...; come spesso accade, una immagine che lo rappresenti ha molto più senso di una descrizione testuale, così ecco le tre coppie di gradienti che dimostrano le modalità “nessuna”, ”riflessa" e “diretta” utilizzando i gradienti mostrati nella coppia in cima:
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  Adesso ritorneremo a quel pulsante ...Modifica. Se vi fate clic, riproporrete una finestra editor di gradiente. Questa è una interfaccia alternativa per modificare i gradienti: potete aggiungere e rimuovere passaggi, cambiare la loro posizione all'interno del gradiente e alterare i loro colori; esattamente le stesse caratteristiche che sono disponibili per la modifica utilizzando lo strumento gradiente sul disegno, tranne che l'editor non vi aiuterà a cambiare la posizione e l'angolo dei vostri gradienti all'interno degli oggetti. La finestra dell'editor di gradiente è stata ufficialmente deprecata, comunque, e probabilmente sarà rimossa in un futuro rilascio a favore di alcune aggiunte alla modifica sul disegno, così non entrerò in maggiori dettagli su di essa.


  Per tutto l'articolo ho parlato del modificare il riempimento. Ma potete anche applicare un gradiente al contorno del vostro oggetto. Qui abbiamo due rettangoli dal contorno spesso, uno con un gradiente lineare per contorno e l'altro con un gradiente radiale:
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  L'essere in grado di utilizzare un gradiente per il contorno può essere un'utile soluzione temporanea per una delle limitazioni dell'SVG (e quindi di Inkscape): i contorni hanno sempre una larghezza fissa. Questa restrizione rende difficile disegnare linee che si assottiglino ma usare un contorno che svanisce fino alla trasparenza può spesso dare un effetto visivo simile, specialmente con le linee sottili:
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  Vi è un'unica caratteristica che salta fuori quando si utilizzano sia i gradienti riempimento che contorno che, a volte, può sembrare un po' come un bug: a Inkscape piace “aiutare” agganciando insieme le maniglie dei gradienti così che possiate manipolarle come una. In questo esempio ho disegnato un quadrato con un riempimento giallo e il contorno blu, poi ho fatto clic sul pulsante del gradiente lineare nella finestra Riempimento e Contorno. Sembra come se vi siano solo un paio di maniglie del gradiente ma questo è perché un insieme si trova sopra l'altro.
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  Se volete modificare solo il gradiente riempimento o contorno la cosa ovvia da fare sarebbe afferrare le maniglie visibili e spostarle fuori dai piedi per rivelare la seconda coppia di sotto, giusto? Se ci provate scoprirete che la propensione di Inkscape ad agganciare insieme le maniglie dei gradienti significa che entrambe gli insiemi di maniglie si muovono come uno solo.
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  La soluzione a questo rompicapo è, semplicemente, tenere premuto il tasto MAIUSC mentre trascinate le maniglie.
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  Adesso che sapete creare i gradienti forse è tempo di sostituire le semplici sfumature sfocate del vostro pupazzo di neve con alcuni gradienti radiali, per dargli un po' più di profondità. Non scordate i gradienti lineari per il suo naso, braccia, pipa e cappello. Come tocco finale, un cielo graziosamente sfumato di solito è più interessante di un piano uniforme.
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    Mark usa Linux dal 1994 e usa Inkscape per creare due fumetti sul web, `The Greys’ e `Monsters, Inked’, che potete trovare su: http://www.peppertop.com/
  


  Inkscape – Parte 6


  di Mark Crutch


  Questa puntata introdurrà il più potente mezzo di disegno delle primitive di Inkscape: i Tracciati. Dico 'introdurrà' perché i tracciati possono essere creati, usati e manipolati in molti modi differenti, così ci ritorneremo ancora e ancora mentre questi tutorial progrediscono.


  [image: ]Ma, questo mese, faremo cose semplici e inizieremo con lo strumento Linea (MAIUSC+F6, o “b”).


  Selezioniamo lo strumento, facciamo clic una volta sulla tela, poi muoviamo il cursore verso un'altra parte della tela prima di fare doppio clic per terminare il nostro tracciato.


  Abbiamo appena creato il più semplice tipo di tracciato che ci sia: una linea retta. Provate a dare un colore e uno spessore al bordo utilizzando la finestra Riempimento e Contorni o gli strumenti sulla barra di stato che abbiamo trattato in precedenza. Adesso passiamo allo strumento Selezione (ricordate che, come scorciatoia rapida, basta solo premere la barra spaziatrice) e confermiamo che possiamo ridimensionarlo, ruotarlo e spanderlo proprio come ci si aspetterebbe. Facciamo doppio clic sulla linea per passare alla modalità di modifica e ci accorgeremo di qualcosa un po' fuori dell'ordinario: mentre il doppio clic su un rettangolo, ellisse o stella ci condurrà allo strumento appropriato, il doppio clic su un tracciato ci condurrà invece allo strumento Nodi.[image: ].


  Familiarizzerete abbastanza presto con lo strumento Nodi ma, per adesso, selezioniamo di nuovo lo strumento Linea. Questa volta facciamo clic sulla tela in diversi posti prima di terminare con un doppio clic. Abbiamo appena creato un tracciato con una linea a segmenti multipli. Vi sono possibilità che abbiate ottenuto un tracciato 'aperto', uno in cui le due estremità sono separate. Se ne disegnate un altro, ma facendo doppio clic al punto d'inizio, creerete un tracciato 'chiuso'. La differenza tra i due diviene evidente quando si aggiunge un riempimento e ciò dovrebbe ricordarvi dell'effetto che abbiamo ottenuto quando abbiamo creato degli archi all'inizio di questa serie.


  
    [image: ]

    Come possiamo vedere, se applichiamo un riempimento a un tracciato aperto, verrà disegnato come se ci fosse una linea retta che chiude il tracciato. Questa, a volte, può essere una caratteristica utile, tuttavia funziona soltanto quando c'è una sola rottura nel tracciato, non appena ne introduciamo un altra (vedremo come farlo il mese prossimo), il riempimento scompare del tutto.


    Ritorniamo allo strumento Nodi [image: ] facendo doppio clic su uno dei tracciati oppure premendo i tasti F2 o “n”. Il doppio clic cambierà strumenti e selezionerà il tracciato; se avete optato per la scorciatoia da tastiera, potreste dover fare clic sul tracciato per assicurarvi che sia selezionato. Dovrete vedere una piccola maniglia a forma di diamante che segna ogni transizione tra i segmenti della linea. Queste vengono chiamate 'nodi' e, come potete immaginare, lo strumento Nodi è ciò che useremo per manipolarle.
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    Proviamo a trascinare in giro col mouse uno dei nodi. Ora premiamo MAIUSC mentre facciamo clic su diversi nodi per selezionarli (si colorano di giallo quando sono selezionati) e trasciniamoli tutti attorno come se fossero uno. Volete muovere i nodi ad ogni estremità del segmento? Basta fare clic sulla linea che li unisce. Mentre lo fate tenete premuto MAIUSC per aggiungere entrambe i nodi a una selezione esistente. Possiamo anche premere “!” (MAIUSC+1 sulla mia tastiera) per invertire la selezione, il che può essere utile, specialmente quando si fanno operazioni con tracciati molto complessi. Infine, proviamo a trascinare una casella di selezione a 'elastico' sopra alcuni dei nostri nodi; facendo clic sulla tela e tenendo premuto il pulsante del mouse, trasciniamo un rettangolo che copra alcuni dei nodi. Rilasciamo il pulsante del mouse e, all'interno della casella, i nodi verranno selezionati (o aggiunti alla nostra selezione se premiamo anche MAIUSC).


    Naturalmente si può fare di più con i nodi, oltre che muoverli in giro. Selezioniamone alcuni, poi attiviamo il pulsante 'Mostra Maniglie' [image: ] sulla barra di controllo dello strumento. Vedremo le familiari maniglie muovi/ridimensiona attorno ai nodi; facendo clic su uno dei nodi selezionati, si passerà invece alle maniglie ruota/distorci. Queste funzionano allo stesso modo delle maniglie che otteniamo con lo strumento Selezione, ma le trasformazioni vengono applicate ai nodi selezionati anziché all'intero oggetto.
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    Ripensate all'articolo precedente, quando stavamo modificando i gradienti direttamente sulla tela. Aggiungere un nuovo passaggio gradiente era tanto semplice quanto fare doppio clic sulla linea dove volevamo che apparisse. Aggiungere un nuovo nodo a un tracciato è analogo: facciamo doppio clic sul tracciato. Se lo vogliamo esattamente a metà del segmento allora selezioniamo i nodi in entrambe le estremità (ricordate, lo si fa un clic sul segmento) e premiamo il tasto INSERT o facciamo clic sul pulsante sulla barra di controllo dello strumento. Il nuovo nodo verrà automaticamente aggiunto alla selezione così possiamo premere ripetutamente INSERT [image: ] o fare clic sul pulsante, mostrato a sinistra, per aggiungere parecchi nodi a una linea segmento.


    Rendiamole un po' più curve. Facciamo clic e trasciniamo il centro di uno dei nostri segmenti della linea per trasformarla rapidamente in una 'curva Beziér'. I nodi in ciascuna estremità della curva dovrebbero avere delle maniglie circolari attaccate tramite delle linee sottili. Si possono già estendere delle curve approssimative dai segmenti della linea retta, ma possiamo ritoccarle muovendo in giro queste maniglie circolari.
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    Se decidiamo di voler cambiare di nuovo la curva di Beziér in una linea retta, per prima cosa dobbiamo selezionare i nodi finali, premere quindi MAIUSC+L o usare il pulsante sulla barra di controllo dello strumento [image: ]. C'è un pulsante adiacente (o MAIUSC+U) per convertire una linea retta in una curva, ma la maggior parte delle volte è più utile trascinare il segmento linea per ottenere la forma approssimata voluta per poi regolarla meglio con le maniglie Beziér.


    I piccoli nodi a forma di diamante con cui abbiamo giocato fin'ora sono solo uno dei quattro tipi di nodi che possono essere usati nei tracciati. Questi nodi consentono ai segmenti dei tracciati di estendersi in qualunque direzione, consentendoci di creare angoli nei nostri tracciati. A volte, comunque, gli angoli acuti sono l'ultima cosa che volgiamo, così, per quelle occasioni, vi sono tre altri tipi di nodi: curvo, simmetrico, auto-curvo. Possiamo scorrere tra i vari tipi di nodi facendo CTRL+clic su un nodo oppure possiamo passare direttamente al tipo voluto selezionando il nodo(i) e poi usando i pulsanti sulla barra di controllo dello strumento:
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    Ecco un rapido sommario dei quattro tipi di nodo:


    
      	Angolo: consente ai segmenti della linea di incontrarsi a un angolo


      	Curvo: assicura che il gradiente rimanga costante da un segmento a un altro


      	Simmetrico: come Curvo, ma assicura inoltre che le due maniglie siano della stessa lunghezza


      	Auto-curvo: muovendo questo nodo, o quelli a lui vicini, manterrà la linea curva. Se regoliamo le maniglie su questo nodo, esso ritornerà comunque a un semplice Nodo curvo.


    


    Naturalmente il modo migliore per comprendere le differenze tra questi quattro tipi consiste, semplicemente, nel disegnare una linea con una manciata di nodi e giocare con essi.


    Disegnare una serie di segmenti da zero utilizzando lo strumento Linea è solo un modo per creare un tracciato, ma Inkscape ne ha parecchi altri. Uno degli approcci più comuni è convertire un altro oggetto in un tracciato. Ciò permette di trasformare facilmente un rettangolo, un ellisse o un poligono in un tracciato i cui nodi possono essere mossi e modificati liberamente. Il lato negativo di questa libertà è che l'oggetto perde la sua originaria identità; una volta che è stato convertito, non saremo in grado di utilizzare lo strumento Rettangolo per cambiare l'ampiezza dell'angolo in un tracciato o lo strumento Stella per aggiustare il numero di lati del vostro poligono. Non saremo neanche in grado di riconvertire il nostro tracciato al tipo di oggetto originale, anche se non abbiamo apportato nessun cambiamento ai nodi: la conversione è una faccenda strettamente a senso unico.


    Ricordandoci di questi avvertimenti, disegniamo alcuni oggetti e convertiamoli in tracciati. Per iniziare, serve solo creare alcune forme seguendo le istruzioni date nelle precedenti puntate di questa serie. Per esempio, un'ellisse, un rettangolo, un rettangolo arrotondato e una stella. Selezioniamo poi ciascun oggetto e usiamo il comando Tracciato > Oggetto a Tracciato in cima al menù (o se preferite CTRL-MAIUSC-C). Facciamo doppio clic su ciascun tracciato così che possiamo vedere dove Inkscape ha creato i nodi angolo e dove ha creato i nodi curvi.
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    Proviamo a manipolare questi tracciati: muoviamo dei nodi, cambiandoli da angolo a curvo e viceversa, trasciniamo i segmenti linea e aggiustiamo le maniglie Beziér. Aggiungiamo alcuni nodi con un doppio clic, oppure selezionando un segmento e premendo INSERT. Naturalmente possiamo anche cancellare i nodi selezionandoli e premendo CANC (o facendo clic sul pulsante, [image: ] nella barra di controllo dello strumento) ma c'è un piccolo tranello: Inkscape cercherà di preservare la forma originale del tracciato al meglio che può, anche se adesso vi sono meno nodi. Se vogliamo che cancelli il nodo e basta, senza cercare di preservarne la forma, allora dovremo premere CTRL-CANC. La differenza diviene chiara quando vogliamo rimuovere solo un angolo da un rettangolo:
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    Se andiamo troppo in la' nella modifica del nodo (o con qualsiasi altra cosa in Inkscape) possiamo sempre usare il menù Modifica > Annulla (CTRL-Z) e ripristinare i cambiamenti. Inkscape mantiene una cronologia di tutte le modifiche apportate in una sessione così, volendo, possiamo fare ripetutamente Annulla. Date un'occhiata a Modifica > Cronologia modifiche se volete veramente viaggiare indietro nel tempo.


    Nell'insieme, Inkscape è un programma piuttosto stabile, ma all'occasione si bloccherà. Nella mia esperienza ciò capita spesso quando sto modificando tracciati e, di solito, quando cerco di usare la funzione Annulla. Fortunatamente, se può, fa anche un lavoro piuttosto buono nel salvare la nostra opera in un file di backup. Se Inkscape presenta una finestra di dialogo nella quale dice che si è piantato, allora, di solito, mostrerà anche il percorso e il nome del file di backup. In generale, il file è nella stessa cartella del disegno o nella cartella home, se non abbiamo ancora salvato il disegno, e avrà un nome basato sul nome del nostro file, ma con l'aggiunta di una stringa riportante data e ora. Di solito si può aprire il file di backup, salvarlo con un nome diverso e continuare a lavorare come se niente fosse successo. Comunque, come con tutti i file di computer, fare regolarmente il backup paga ; di solito inizio ogni sessione di Inkscape usando File > Salva come... per creare una copia della mia immagine con un nome leggermente diverso così da non perdere mai troppo lavoro a causa di un blocco di Inkscape.


    Adesso che sapete convertire le forme di Inkscape in tracciati, è tempo di far sembrare il nostro pupazzo di neve meno immacolato. Convertiamo la sua testa e il suo corpo ellittico, aggiungiamo poi alcuni nodi e muoviamoli leggermente per produrre bozzi, protuberanze e asimmetrie tipiche di un pupazzo di neve. Possiamo aggiungere un po' più di carattere al suo naso-a-carota disegnando tagli e segni e rendendolo un po' storto in alcune parti. L'orizzonte beneficia di una piccola ondulazione che implica l'accumulo di neve. Sebbene potremmo creare delle braccia più sottili e sgualcire il suo cappello, per ora lasceremo da parte queste cose, occupandocene il mese prossimo quando tratterò alcuni metodi per creare e manipolare rapidamente e con facilità dei tracciati complessi.
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      Mark utilizza Linux dal 1994 e usa Inkscape per creare due fumetti sul web, 'The Greys' e 'Monsters, Inked' che potrete trovare su:

      http://www.peppertop.com/
    

  


  Inkscape – Parte 7


  di Mark Crutch


  Alla fine dell'articolo del mese scorso, ho promesso che avremmo dato uno sguardo anche al cappello che adorna il nostro pupazzo di neve. Il cappello è stato aggiunto nella seconda parte di questa serie, quando tutto quello che potevamo disegnare erano ellissi e rettangoli ed è un buon esempio di come pochi oggetti scelti con cura possano ingannare gli occhi nel far vedere forme che invece non ci sono. Ecco come appare quando è rimosso dalla testa del pupazzo di neve e ruotato un pochino.
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  C'è ovviamente una ellisse in cima e un'altra per la tesa , ma cos'è la parte principale del cappello? Con le nostre nuove conoscenze del mese scorso, sarebbe semplice crearlo convertendo un rettangolo in un percorso, e curvando i segmenti in cima e in fondo, ma questa versione anticipa di diversi mesi questa intuizione. Esplodere il cappello nelle sue componenti rende le cose un po' più chiare:
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  Il corpo è solo un rettangolo con un'ellisse che spunta fuori da sotto di esso. Dando a essi un abbinato gradiente possiamo creare l'illusione di un singolo oggetto. La curva in cima non esiste proprio, è solo un effetto ottico creato mettendo il rettangolo dietro l'ellisse che forma la sommità del cappello.


  Ingannare l'occhio per effetti artistici può essere molto utile, ma, in questo caso, era solo un trucco per la nostra mancanza di conoscenza di Inkscape. Sarebbe stato meglio se il corpo del cappello fosse un solo elemento con un gradiente. Il nostro cappello completo sarebbe costituito in un'ellisse per la cima, un'ellisse per la tesa e un percorso per il corpo. Avremmo potuto fare questo convertendo il rettangolo in un percorso e cambiando il bordo inferiore in una curva di Bezier:
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  Ma abbiamo già ottenuto la forma che vogliamo nel contorno formato dal rettangolo e dall'ellisse. Quello che davvero vogliamo fare è combinare questi oggetti in un singolo percorso. Per fare in modo che Inkscape sappia quali elementi vogliamo combinare, il nostro primo passo è selezionare entrambi. Passate allo strumento di selezione, fate clic sul rettangolo e quindi tenendo premuto il tasto SHIFT mentre premete sull'ellisse. La barra di stato quindi vi dirà che avete “2 oggetti di tipo Rettangolo, Ellisse” selezionati. Se no, usate Edit > Deselect (o fate clic sullo sfondo, lontano da ogni altro oggetto) per pulire la vostra selezione e provate ancora. Una volta che siete soddisfatti per avere selezionato i due oggetti giusti, usate la voce di menu Path > Union (CTRL-+) per combinare i vostri oggetti in un singolo percorso:
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  Se ingrandite noterete che il vostro nuovo percorso non è perfetto come vorreste. Alcuni disallineamenti dell'ellisse rispetto al rettangolo sono diventati nodi aggiuntivi che sono stati creati e che dobbiamo modificare a mano usando lo strumento Node. Creare percorsi da altri oggetti in questo modo può essere un metodo veloce per ottenere un contorno di partenza di una forma, ma, di solito, poi dovete fare alcuni aggiustamenti manuali.
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  Così come si possono unire forme insieme per formare un singolo percorso, possiamo anche sottrarle, tagliando una forma dall'altra. Guardando alla sommità del cappello possiamo usare l'ellisse per tagliare via una sezione curva. Non c'è bisogno di essere un genio matematico per comprendere che 1-2 non vi da lo stesso risultato che 2-1. Analogamente sottraendo un rettangolo da un'ellisse non vi da lo stesso risultato che sottrarre un'ellisse da un rettangolo, così Inkscape ha bisogno di conoscere quale oggetto sia quello che stiamo rimuovendo, e quale sia quello da cui stiamo rimuovendo. Questo è fatto con l'ordine di impilazione.


  L'ordine di di impilazione è stato brevemente menzionato nella prima parte di questa serie: gli oggetti in Inkscape possono essere uno sopra l'altro, con quelli che stanno in cima alla pila che oscurano quelli sotto (supponendo che siano completamente opachi). Quando voi avete selezionato un oggetto usando lo strumento Selection potete muoverlo su e giù nello pila usando questi quattro pulsanti nella barra di controllo degli strumenti:
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  Per tagliare un oggetto da un altro, la forma che deve essere rimossa deve essere sopra all'altro oggetto, nel nostro caso l'ellisse deve essere sopra al rettangolo-con-una-base-curva. É probabilmente già in cima alla pila, ma non fa male abituarsi a muovere sempre l'oggetto che taglia sopra all'oggetto che deve essere tagliato. Questo è facile da ottenere selezionando l'ellisse e usando l'ultimo dei quattro pulsanti per portarlo proprio in cima all'ordine di impilazione. Ora voi dovete posizionare l'ellisse per ritagliare la forma che volete, in questo caso sovrapponendo i bordi del rettangolo. Fatto questo, è semplice selezionare entrambi gli oggetti e usare la voce di menu Path > Difference (o la combinazione di tasti CTRL e il tasto meno) per sottrarre l'ellisse dal rettangolo:
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  Sfortunatamente ci sono un paio di problemi con il risultato: il primo è che, una volta ancora abbiamo alcuni nodi che debbono essere ripuliti manualmente; il secondo è che la nostra ellisse è completamente scomparsa! Questo è un effetto collaterale della operazione Path > Difference: l'oggetto che voi state ritagliando è anche rimosso nel processo.


  Premete CTRL-Z (o usate Edit > Undo) per ripristinare la vostra ellisse allo stato pre-taglio. Ora selezionate solo l'ellisse e usate Edit > Duplicate (CTRL-D). Questo creerà una copia dell'oggetto selezionato esattamente nella stessa posizione sullo spazio ma in cima alla pila. É utile abituarsi alle scorciatoie da tastiera perché questa è una caratteristica particolarmente utile – non solo vi fornisce una copia disponibile del vostro oggetto ritagliante da usare, ma inoltre vi risparmia di doverlo manualmente muovere in cima alla pila. Lascia perfino il nuovo oggetto selezionato, in modo tale che dovete solo premete SHIFT-clic sull'oggetto per essere tagliato, e quindi usate Path > Difference. Ora il nostro precedente rettangolo ha una base curva e una sommità curva, e abbiamo ancora un'ellisse per formare la tesa.
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  Ma c'è ancora un problema. Un'attenza osservazione alla giunzione tra il rettangolo curvo e la tesa mostra una linea sottile che si evidenzia attraverso la tela o gli oggetti sotto. Inkscape usa “anti-aliasing” quando disegna i suoi oggetti. Questo effetto prova ad approssimare bordi che non cadono precisamente sui confini dei pixel disegnando una linea sottile e traslucente per dare l'impressione di una curva morbida. Di solito funziona bene, ma quando si incontrano due bordi fatti così può portare a una sottile differenza dove davvero la volete.


  Ci son un paio di soluzioni a questo problema di anti-aliasing: possiamo aggiungere un tratto a uno o a entrambi gli oggetti per coprire la differenza, ma questo è non è sempre appropriato e non aiuta se gli oggetti hanno già dei tratti; in alternativa potete evitare di basarsi su oggetti perfettamente confinanti l'uno all'altro facendo in modo che uno di loro sovrapponga il bordo dell'altro. In questo caso non abbiamo davvero bisogno che il rettangolo abbia la parte superiore curva – abbiamo già l'effetto visuale che stavamo cercando con l'ellisse posizionata sopra il rettangolo.


  Lasciate che CTRL-Z ci faccia tornare indietro al nostro cappello tagliato dritto. Può sembrare che abbiamo fatto un giro a vuoto, ma lungo il percorso avete imparato Path > Difference, i problemi visuali che l'anti-aliasing può provocare alcune volte, e il fatto che qualche volta è meglio disegnare qualcosa che sembra giusto anche se la sua struttura sottostante non è corretta come preferibile. Prima di riassemblare definitivamente il cappello, forse vale la pena di aggiungere un po' di pieghe e accartocciamenti usando gli strumenti per i tracciati del mese scorso:


  
    [image: ]

  


  Mentre voi siete nel menu Path cercando Union e Difference, probabilmente avete notato le altre voci del menu vicine ad esse: Intersection (ndt Intersezione), Division (ndt Divisione), Exclusion (ndt Esclusione) e Cut Path. Tutti questi formano le operazioni "Booleane" sui percorsi, denominate così dal matematico del 19 esimo secolo George Boole che formulò queste regole per combinare i dati binari che sottostanno a queste operazioni. Tutte queste richiedono due oggetti (anche se Union può funzionare con più di due), con il risultato che di solito differisce in funzione di quale degli oggetti è più alto nella pila. La tabella sopra dimostra gli effetti di applicare ciascuna di queste operazioni a un quadrato sovrapposto a un cerchio, e mostra le differenze nel risultato in funzione di quali di questi oggetti sia sopra all'altro (nel caso di Division e Cut Path gli oggetti risultanti sono stati separati leggermente per rendere più facile vedere gli effetti di queste operazioni).


  
    
      
        	Oggetti originali
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        	Taglia tracciato
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  Con un po' di pratica queste operazioni Booleane vi permetteranno di produrre percorsi complessi a partire da poche forme semplici. Questo fornisce un modo rapido per produrre un contorno iniziale grezzo che poi possiamo migliorare con lo strumento dei nodi in qualcosa di più rifinito. Ma non considerateli solo come un corpo contundente per lavori di costruzione grossolana: essi possono essere usati anche per scolpire e dare forma con la precisione di uno scalpello.


  
    Mark utilizza Linux dal 1994 e usa Inkscape per creare due fumetti sul web, 'The Greys' e 'Monsters, Inked' che potrete trovare su: http://www.peppertop.com/
  


  Il gruppo FMC Italia


  ENTRA ANCHE TU NEL GRUPPO FCM
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  La rivista Full Circle nasce da una idea della Comunità degli utenti di Ubuntu e vive del lavoro di coloro che hanno scelto di dedicare parte del loro tempo libero alla riuscita di questo progetto. È un progetto veramente aperto : tutti possono collaborare, in un modo o nell’altro. C’è chi scrive gli articoli, chi li corregge, chi li traduce, chi li impagina e così via.


  Anche tu puoi collaborare attivamente alla continua crescita di questa rivista, il cui unico scopo è la diffusione della cultura del Software Libero.


  Se conosci l'inglese e il Software Libero è la tua passione, puoi collaborare:


  
    	Scrivendo articoli in inglese;


    	Traducendo in italiano i testi;


    	Revisionando i testi;


    	Impaginandoli con Scribus;



    	Impaginandoli con Sigil.

  


  Se vuoi saperne di più, visita la pagina Partecipare del nostro wiki.

  

  Oggi partecipare è ancora più facile!


  Coordinatori del gruppo: Fabrizio Nicastro - Mattia Rizzolo

  


  I collegamenti per scaricare tutti i numeri di Full Circle Magazine in italiano li trovi nel nostro Archivio.


  Cerchi un articolo pubblicato su FCM?


  Nel wiki trovi anche l'Indice generale di tutti i numeri pubblicati, comprensivo di titolo, autore e pagina dell'articolo. Fai clic qui per consultarlo!

  


  Questa rivista è stata tradotta dal Gruppo FCM della comunità Ubuntu-it.


  Per ogni altra informazione visitate il nostro sito web: http://wiki.ubuntu-it.org/Fcm.
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